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PXIe-5654PXIe-5654  User Manual User Manual 
The PXIe-5654 User Manual provides detailed descriptions of the product functionality 
and the step-by-step processes for use. 

Looking For Something Else? 

For information not found in the User Manual for your product, such as specifications 
and API reference, browse Related Information. 

Related information: 

• NI Hardware and Software Operating System Compatibility 
• PXIe-5654 Specifications 
• PXIe-5654 Calibration Procedure 
• RFmx User Manual 
• NI RF Signal Generators User Manual 
• Software and Driver Downloads 
• License Setup and Activation 
• Release Notes 
• NI Learning Center 
• NI Community 

PXIe-5654 User Manual
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PXIe-5654PXIe-5654  Overview Overview 
The PXIe-5654 is a PXI RF analog signal generator designed for testing phase noise and 
frequency tuning time. Use the PXIe-5654 for blocker test and receiver desensitization, 
high-performance intermodulation distortion measurements, and electronic warfare 
applications. The PXIe-5654 meets the requirements of RFIC characterization, satellite 
test, and radar applications. 

The PXIe-5654 name encompasses the following instruments: 

Table 1. PXIe-5654 Instruments 

Instrument Part Numebrs Constituent Modules 

PXIe-5654 783126-01, 783126-02, 
783127-01, 783127-02 PXIe-5654 

PXIe-5654 with Amplitude 
Extender 

784776-01, 784776-02, 
784777-01, 784777-02 PXIe-5654 , PXIe-5696 

Key Features 

• 250 kHz to 20 GHz frequency range 
• -10 dBm to +13 dBm amplitude range, depending on frequency 
• Up to +27 dBm extended amplitude range 
• Up to +27 dBm output power (typical) with 130 dB of RF output power range 
• 100 µs frequency-switching speed 
• -133 dBc/Hz phase noise at 1 GHz, 10 kHz offset (typical) 

PXIe-5654 Overview
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Driver Support Driver Support 
Use NI-RFSG to configure and operate the PXIe-5654 , perform waveform programming 
and generation, and perform basic modulation tasks using LabVIEW VIs or 
LabWindows/CVI functions. NI-RFSG provides the standard IVI-based functionality 
needed for most RF signal generator applications. NI-RFSG includes an interactive soft 
front panel and examples. 

Tip To optimize product performance, update to the most recent driver 
version. 

Driver Support
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Components of a Components of a PXIe-5654PXIe-5654  System System 
PXIe-5654 is designed for use in a system that may require hardware, drivers, and 
software to optimize PXIe-5654 for your application. Use the minimum required 
PXIe-5654 system components as a starting point for building your system. 

Table 2. Minimum Required PXIe-5654 System Components 

Component Description and Recommendations 

PXI Chassis 

A PXI chassis houses the PXIe-5654 and supplies power for 
PXIe-5654 functions. 

PXI Controller or PXI Remote Control 
Module 

You can install a PXI controller or a PXI remote control 
(MXI) module depending on your system requirements. 
These components, installed in the same PXI chassis as 
the PXIe-5654 , interface with the instrument using NI 
device drivers. 

PXI RF Analog Signal Generator Your generator instrument. 

Components of a PXIe-5654 System

© National Instruments 7



Component Description and Recommendations 

Cables and Accessories 

Cables and accessories allow connectivity to/from your 
instrument for measurements. Refer to Cables and 
Accessories for recommended cables and accessories 
and guidance. 

Driver Software Instrument driver software that provides functions to 
interact with the PXIe-5654 and execute measurements 
using the PXIe-5654 . 

NI Applications Instrument driver software offers support for the following 
applications: 

• InstrumentStudio 
• LabVIEW 
• LabWindows/CVI 

Note For optimal performance, use the most 
current version of driver software with the 
PXIe-5654 . You can find the driver 
requirements on ni.com. 

Components of a PXIe-5654 System
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Component Description and Recommendations 

• C/C++ 
• .NET 
• Python 

Components of a PXIe-5654 System
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Part Numbers for Recommended Cables and Part Numbers for Recommended Cables and 
Accessories Accessories 
Use part numbers to purchase the cables and accessories NI recommends to optimize 
the performance of PXIe-5654 . 

Contact NI for purchase information. 

Table 3. Part Numbers for Recommended Cables and Accessories 

Accessory/Cable Description Part Number 

Cable assembly, semi-rigid SMA-SMA, RF-AMP OUT-ATTEN 
IN 155081B-01 

Cable SMB-SMB, ALC IN PXIe-5654 to 
ALC OUT PXIe-5696 , 5" 157672A-05 

Cable assembly, semi-rigid SMA-SMA, RF-OUT PXIe-5654 to 
RF AMP-IN, PXIe-5696 155082B-01 

Part Numbers for Recommended Cables and Accessories
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PXIe-5654PXIe-5654  Theory of Operation Theory of Operation 
Refer to block diagrams and state models to understand the hardware and software 
design behind the PXIe-5654 . 

PXIe-5654 Block Diagram PXIe-5654 Block Diagram 
This section contains a high-level block diagram for the PXIe-5654 RF Analog Signal 
Generator and descriptions of individual blocks. 

The CPU manages the control signals and data transferred between the circuit blocks. 
The CPU controls all internal registers and components necessary for frequency 
generation, modulation, and amplitude control. The CPU communicates directly with 
the host computer. Additionally, the CPU monitors temperature, health, and status of 
the module and flags any operation or temperature problems. The following list 
describes the individual blocks of the PXIe-5654: 

• Clocking circuitry contains the system clock reference and the direct digital 
synthesizer (DDS). The system clock is a 100 MHz oven-controlled crystal oscillator 
(OCXO) that you can configure to phase-lock to an external reference of 1 MHz to 
20 MHz in 1 MHz intervals that is present at the REF IN front panel connector. 

The REF OUT connector provides a 10 MHz reference output signal and the 
REF OUT 2 provides a 100 MHz reference output signal. You can independently 
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control these output signals and use them to provide a reference to additional test 
instruments. 

Additionally, you can calibrate the internal frequency reference to remove the 
effects of aging by applying an external frequency reference standard, such as GPS 
or rubidium, to the REF IN connector, and then you can execute an OCXO 
calibration sequence. 

• Signal generation occurs inside the main synthesizer circuit. The synthesizer is 
phase-locked to the Reference Clock. Following the main synthesizer are the 
dividers to scale the frequency. 

• The amplitude control circuit performs amplitude control, and the power 
control circuit has a control range of ≥20 dB with 0.01 dB resolution. 

• After the amplitude control circuit, a switched filter bank ensures adequate 
harmonic suppression for each hardware band. Refer to the PXIe-5654 
Specifications document for typical suppression values. 

• Modulation capabilities include amplitude modulation (AM), frequency 
modulation (FM), phase modulation (PM), and pulse modulation. The pulse 
modulation circuit performs the pulse modulation, the main synthesizer 
performs the FM, and the amplitude control circuit performs the AM. 

• Use the ALC IN front panel connector only in conjunction with the PXIe-5696 
Amplitude Extender (AE). The automatic leveling control (ALC) utilizes a 
temperature-stable voltage reference and digital-to-analog converter (DAC) in the 
AE module to perform fine amplitude corrections in the amplitude control circuit 
of the PXIe-5654. This provides accurate power levels over the whole frequency 
generation range from 250 kHz to 20 GHz and -110 dBm to +30 dBm, although the 
maximum power varies with frequency. Refer to the PXIe-5654 Specifications 
document for output power specifications according to frequency. 

• Use the TRIG IN/OUT front panel connector for synchronization of various steps 
during RF list mode operation. 

The CPU uses the calibration data stored in the FLASH memory to correctly set up the 
hardware for signal generation. The device uses the calibration data to compensate for 
non-ideal components and temperature variation. 

PXIe-5654 Theory of Operation
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Hardware State Diagram Hardware State Diagram 
The following diagram shows the hardware states of the PXIe-5654 

Get/Set Attribute Get/Set AttributeGet Attribute

Initiate

Generation
(Running)

Commit
(or Aborted)

Configuration
(Idle)

AbortSet Attribute

Commit

Initialize

Initiate

• Configuration (Idle)- The device is not generating a signal. All session 
properties or attributes can be programmed in the Configuration state. In the 
Configuration state, the properties or attributes have not necessarily been applied 
to hardware, and the hardware configuration of the device may not match the 
session property or attribute values. The device remains configured as it was the 
last time a session was committed. If the computer has just been powered on, 
reset, or theniRFSG Reset Device VI or the niRFSG_ResetDevice function has just 
been called, the device is in the default hardware state. 

• Commit (or Aborted)- Applies the device properties or attributes to the 
hardware. 

• Generation- In the Generation state, the device is generating a waveform as 
specified by the session properties or attributes configured. Dynamic (or on-the-
fly) properties and attributes are applied immediately to hardware. Dynamic 
properties and attributes can be applied to the device immediately if set while the 
session is in the Generation state. 

PXI Trigger Lines PXI Trigger Lines 
Eight PXI bus trigger lines are highly flexible and can be used in a variety of ways. 

You can use PXI bus lines in the following ways: 

• To synchronize the operation of several different PXI peripheral devices 
• To use one device to control carefully timed sequences of operations performed on 

other devices in the system 
• To pass triggers between devices, allowing precisely timed responses to 

PXIe-5654 Theory of Operation
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asynchronous external events that are being monitored or controlled 

The number of triggers that an application requires varies with the complexity and 
number of events involved. 

The PXI Specification is implemented with the RTSI bus through the PXI trigger lines. 
PXI Specification requires eight lines, PXI_Trig<0..7>, on the P2/J2 connector of the PXI 
chassis for the trigger lines. 

System Reference Clock System Reference Clock 
The PXI chassis supplies the PXI 10 MHz system Reference Clock signal (PXI_CLK10), 
independently to each peripheral slot. 

An independent buffer drives the clock signal to each peripheral slot. The buffer has a 
source impedance matched to the backplane and a skew ranging from less than 1 ns to 
greater than 250 ps between slots. You can use this common Reference Clock signal to 
synchronize multiple devices in a measurement or control system. Sourcing an 
external clock on this pin automatically disables the 10 MHz source on the backplane. 
You can synchronize multiple chassis that have connectors on the back panel for 
10 MHz reference in and 10 MHz reference out. Refer to your PXI chassis 
documentation for more information. 

Note PXI Express chassis have a PXI 10 MHz system clock signal, but NI-RFSG 
devices cannot drive it. 

PXIe-5654 Theory of Operation

14 ni.com



PXIe-5696 Block Diagram PXIe-5696 Block Diagram 
This topic contains information about the PXIe-5696 Amplitude Extender high-level 
block diagram and descriptions of the individual blocks. 

The system control unit (SCU) manages the control signals and data transferred 
between the circuit blocks. The SCU controls all internal registers and components 
necessary for filtering, amplification, automatic level control (ALC), and amplitude 
control. The SCU communicates directly with the host computer. Additionally, the SCU 
monitors temperature, health, and status of the module and flags any operation or 
temperature problems. The following list describes the individual blocks of the 
PXIe-5696: 

• The PXIe-5696 amplitude extender (AE) module contains two input terminals, 
including the RF IN and the ATTN IN front panel connectors. 

• The RF IN connector provides two internal paths, including the low harmonic 
path and the high power path. 
◦ The internal low harmonic path contains a bank of switched amplifiers and 

filters to ensure adequate harmonic suppression for each hardware band. 
Refer to the PXIe-5654 Specifications document for harmonic performance 
specifications. 

◦ The internal high power path contains a power amplifier to boost the output 
power output from 250 MHz to 20 GHz. Refer to the PXIe-5654 
Specifications document for PXIe-5696 output power values. 

• The ATTN IN connector includes an ALC and a 110 dB mechanical step 

PXIe-5654 Theory of Operation
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attenuator. 
◦ The ALC utilizes a temperature-stable voltage reference and digital-to-analog 

converter (DAC) in the AE module to perform fine amplitude corrections using 
the amplitude control circuit of the PXIe-5654 RF Analog Signal Generator. 
The ALC is used to provide accurate RF power levels over the whole frequency 
generation range from 250 kHz to 20 GHz and amplitude control range. Use the 
ALC OUT front panel connector only in conjunction with the PXIe-5654 module. 
Refer to the PXIe-5654 Specifications document for PXIe-5696 amplitude 
accuracy. 

◦ The mechanical step attenuator provides coarse amplitude control and can be 
set in 10 dB steps from 0 dB to 110 dB. When you use the PXIe-5696 with the 
PXIe-5654, the PXIe-5654 performs fine amplitude control. 

The SCU uses the calibration data stored in the FLASH memory to correctly set up the 
hardware for accurate power control. The device uses the calibration data to 
compensate for internal components and temperature variation. 

PXIe-5654 Theory of Operation
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Frequency Tuning Times Frequency Tuning Times 
The PXIe-5654 is a highly agile frequency synthesizer. When the fast tuning option is 
available, the PXIe-5654 can usually tune to and from any frequency in 100 µs or 150 µs 
when tuning to frequencies less than 250 MHz. 

One exception occurs when the device switches from a higher frequency to a 
frequency of 250 MHz or less; if a frequency switch crosses the 250 MHz threshold in a 
high-to-low direction, the frequency settling time increases. The standard switching 
time without the fast tuning option is 1 ms. 

Note Refer to the PXIe-5654 Specifications document for frequency 
settling times. 

Frequency Tuning Times
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Amplitude Settling Times Amplitude Settling Times 
Each time the frequency switches, there is an accompanying amplitude settling time 
associated with the internal hardware settings change. You can use NI-RFSG to set 
desired amplitude settling values and ensure that the amplitude is settled. You may 
experience overshoot or undershoot in amplitude level while the amplitude settles. 

Amplitude settling takes different lengths of time depending on whether the device 
ALC is operating in open-loop mode or closed-loop mode. 

Note Refer to the PXIe-5654 Specifications document for amplitude 
settling times. 

Amplitude Settling Times
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Phase Noise and Signal-to-Noise Ratio Phase Noise and Signal-to-Noise Ratio 
The PXIe-5654 uses a patented QuickSyn architecture to allow quick frequency 
changes in 100 µs, while retaining good close-in phase noise that is typically reserved 
for YIG-based signal sources. 

This close-in phase noise performance allows good signal-to-noise ratio (SNR) for 
radar and communication applications. This SNR combined with fast frequency 
switching reduces production measurement testing time while the accuracy of each 
measurement is maintained. 

Note Refer to the PXIe-5654 Specifications document for specified 
phase noise performance. 

Phase Noise and Signal-to-Noise Ratio
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NI-RFSGNI-RFSG  Examples Examples 
Examples demonstrate the functionality of the device and serve as programming 
models and building blocks for your own applications. The NI Example Finder is a 
utility available for some ADEs that organizes examples into categories and allows you 
to easily browse and search installed examples. You can see descriptions and 
compatible hardware models for each example or see all the examples compatible 
with one particular hardware model. 

You can locate LabVIEW or LabWindows/CVI examples with the NI Example Finder. 
Within LabVIEW or LabWindows/CVI, select Help » Find Examples and navigate to 
Hardware Input and Output » Modular Instruments. 

NI-RFSG Examples
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PXIe-5654 Front Panel and LEDs PXIe-5654 Front Panel and LEDs 
This section describes the connectors and LED indicators on the PXIe-5654 RF Analog 
Signal Generator front panel. 

Table 6. General Connector Descriptions 

Connector Type Use 

REF IN SMA 

An input terminal that routes an external reference signal to the 
PXIe-5654. This connector accepts a frequency range from 
1 MHz to 20 MHz. REF IN has an input range of -5 dBm to 
+15 dBm and an input damage level of >+20 dBm. 

REF OUT SMA 
An output terminal that routes a 10 MHz signal from the 
PXIe-5654. The device outputs the 10 MHz reference signal at 
+5 dBm, ±2 dBm. 

REF OUT 2 SMA An output terminal that routes a 100 MHz signal from the 
PXIe-5654. The device outputs the 100 MHz reference signal at 
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Connector Type Use 

+5 dBm, ±2 dBm. 

TRIG IN/OUT SMB 

An input/output terminal with a +3.3 V logic level high 
impedance input or low impedance output. This connector has 
a maximum input level of +5 V and an input damage level of 
≤-0.5 V and ≥5.5 V. 

PULSE IN SMB 

An input terminal that accepts a modulating square wave to 
pulse the RF output. PULSE IN has a +3.3 V logic level high 
impedance input. This connector has a maximum input level of 
+5 V and an input damage level of ≤-0.5 V and ≥5.5 V. 

FM IN SMB 
An input terminal for frequency modulation with an input range 
of ±1 Vpk-pk. FM IN has an input damage level of ±2 V. 

AM IN SMB 
An input terminal for amplitude modulation with an input 
range of ±1 Vpk-pk. AM IN has an input damage level of ±2 V. 

ALC IN SMB 

If you use the PXIe-5654 with the PXIe-5696 Amplitude 
Extender, this terminal connects to the ALC OUT connector on 
the PXIe-5696. This connector has an input damage level of 
±15 V. 

RF OUT SMA 
An output terminal for the generated RF signal at the requested 
frequency and power level. This connector covers a frequency 
range from 250 kHz to 20 GHz. 

The following table provides information about the PXIe-5654 module front panel 
LEDs and the device states they indicate: 

Table 7. LED Indicators 

LED Indications 

ACCESS Indicates the basic hardware status of the 
PXIe-5654 module. 

Notice Do not apply an input signal to the 
TRIG IN/OUT connector when it is configured as an 
output or damage may occur. 
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LED Indications 

Off—The module is not yet functional or has 
detected a problem with a PXI Express power 
rail. 

Amber—The module is being accessed. 
Accessed means that the device setup 
transferred in order to control the device. 

Green—The module is ready to be programmed. 

ACTIVE 

Indicates the state of the PXIe-5654 module: 

Off—The module is not generating a signal. 

Green—The module is generating a signal; 
applicable phase-locked loops (PLLs) are locked. 

Red—The module has detected an error state; 
this may indicate a PLL lock failure or a thermal 
shutdown condition. 

Reference Input and Output Connectors Reference Input and Output Connectors 
You can use the PXIe-5654 REF IN connector to phase-lock to an external reference 
source. In addition to using a 10 MHz reference source, you can also lock the reference 
to additional frequencies. The REF IN connector accommodates a wide range of input 
power levels for the RF signal generator to successfully lock to an external reference 
signal. 

The PXIe-5654 REF OUT connector provides a 10 MHz output signal, and the PXIe-5654
REF OUT 2 connector provides a 100 MHz output signal. The output power levels on 
both connectors are not adjustable. You can use both REF OUT and REF OUT 2 

Note Although the devices may be frequency-locked together, their 
generated RF signals are not phase-synchronized. 
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connectors as a reference source to synchronize the RF signal generator with other test 
equipment. You can also independently turn on or off both the REF OUT and 
REF OUT 2 outputs. 

Refer to the PXIe-5654 Specifications for onboard frequency reference input and 
output specifications. 

PXIe-5654 Front Panel and LEDs
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PXIe-5696 Front Panel and LEDs PXIe-5696 Front Panel and LEDs 
This section describes the connectors and LED indicators on the PXIe-5696 Amplitude 
Extender (AE) front panel. 

Table 6. General Connector Descriptions 

Connector Type Use 

RF AMP OUT SMA 

An output terminal that routes the amplified output signal to 
the ATTN IN connector. 

Notice Do not disconnect the cable that connects 
RF AMP OUT to ATTN IN. Removing the cable from 
or tampering with the RF AMP OUT or ATTN IN 
front panel connectors voids the product 
calibration and specifications are no longer 
warranted. 
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Connector Type Use 

ATTN IN SMA 

An input terminal that connects to the RF AMP OUT 
connector. This connector has an input damage level of 
+30 dBm. 

RF IN SMA 

An input terminal that amplifies the incoming signal from the 
PXIe-5654 RF Analog Signal Generator and provides 
additional signal conditioning. RF IN connects to the RF OUT 
connector of the PXIe-5654. This connector has an input 
damage level of +15 dBm. 

ALC OUT SMB 

An output terminal that connects to the ALC IN connector of 
the PXIe-5654. This connector has a maximum output signal 
level of ±15 VDC. 

RF OUT 3.5 mm 
An output terminal for a leveled RF output signal over the 
specified power range. This connector is protected against 
reverse RF power up to +30 dBm. 

The following table provides information about the PXIe-5696 module front panel 
LEDs and the device states they indicate: 

Table 7. LED Indicators 

LED Indications 

ACCESS Indicates the basic hardware status of the 
PXIe-5696 module. 

Notice Do not disconnect the cable that connects 
RF AMP OUT to ATTN IN. Removing the cable from 
or tampering with the RF AMP OUT or ATTN IN 
front panel connectors voids the product 
calibration and specifications are no longer 
warranted. 

Notice Connect this output terminal only to the 
ALC IN connector of the PXIe-5654. Do not connect 
this output terminal to an external source or 
damage may occur. 
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LED Indications 

Off—The module is not yet functional or has 
detected a problem with a PXI Express power 
rail. 

Amber—The module is being accessed. 
Accessed means that the device setup 
transferred in order to control the device. 

Green—The module is ready to be programmed. 

ACTIVE 

Indicates the state of the PXIe-5696 module: 

Off—The module is not enabled. 

Green—The module has been initiated and is 
running 

Red—The module has detected an error state; 
this may indicate an internal failure or a thermal 
shutdown condition. 
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Why Is the ACCESS LED Off When the Chassis Why Is the ACCESS LED Off When the Chassis 
Is On? Is On? 
The LEDs may not light until the device has been configured in MAX. Before 
proceeding, verify that the PXIe-5654 appears in MAX. 

If the ACCESS LED fails to light after you power on the chassis, a problem may exist 
with the chassis power rails, a hardware module, or the LED. 

1. Disconnect any signals from the module front panels. 
2. Power off the chassis. 
3. Remove the module from the chassis and inspect it for damage. Do not reinstall a 

damaged device. 
4. Reinstall the module in a different chassis slot. 
5. Power on the chassis. 
6. Verify that the device appears in MAX. 
7. Reset the device in MAX and perform a self-test. 

Notice Apply external signals only while the PXIe-5654 is powered on. 
Applying external signals while the device is powered off may cause damage. 

Why Is the ACCESS LED Off When the Chassis Is On?
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Safety Guidelines Safety Guidelines 
Hot Surface If the PXIe-5654 has been in use, it may exceed safe handling 
temperatures and cause burns. Allow the PXIe-5654 to cool before removing 
it from the chassis. 

Caution Observe all instructions and cautions in the user documentation. 
Using the product in a manner not specified can damage the product and 
compromise the built-in safety protection. Return damaged products to NI 
for repair. 

Attention Suivez toutes les instructions et respectez toutes les mises en 
garde de la documentation d'utilisation. L'utilisation du produit de toute 
autre façon que celle spécifiée risque de l'endommager et de compromettre 
la protection de sécurité intégrée. Renvoyez les produits endommagés à NI 
pour réparation. 
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Device Warm-Up Device Warm-Up 
NI recommends warming up the PXIe-5654 hardware for 30 minutes before operation. 

The unit is fully functional prior to this time, but frequency, amplitude accuracy, and 
other specifications are not at warranted levels until the device has fully completed 
warming up. 

Note Warm up begins when the PXI Express chassis has been powered on 
and the operating system has completely loaded. 

Device Warm-Up
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Temperature Monitoring Temperature Monitoring 
Both the PXIe-5654 RF signal generator module and the PXIe-5696 Amplitude Extender 
module have an internal temperature sensor that monitors the RF analog circuitry 
temperature. You can query these internal temperature sensors using NI-RFSG . 

The PXIe-5654 RF signal generator module queries its temperature sensor at defined 
intervals to correct for amplitude deviations as the operating temperature and 
ambient temperature changes. NI-RFSG polls the temperature sensor of the PXIe-5696
to correct for amplitude deviations as the operating temperature and ambient 
temperature changes. 

Thermal Shutdown Thermal Shutdown 
NI-RFSG supports thermal shutdown monitoring for NI RF signal generator modules. 
This feature allows the module to detect when it has reached a dangerously high 
temperature and to then power off, preventing damage to the device. 

If safe temperature limits are exceeded, the RF enclosure is powered off, and NI-RFSG
returns an error. 

Querying Device Temperature 
Query the value of the Device Temperature property or the 
NIRFSG_ATTR_DEVICE_TEMPERATURE attribute to return the temperature of the 
internal RF circuitry of the PXIe-5654 . 

Note If a temperature sensor reports a temperature above 80 °C, the PXI 
Express power rails to the RF signal generator or amplitude extender shuts 
down to protect the RF circuitry from damage. 

Note The PXIe-5654 is warm to the touch during normal operation. The 
device should never reach a temperature high enough to cause thermal 
shutdown unless the fan or vents on the PXI or PXI Express chassis are 
blocked or the filters on the fans are excessively dusty. 
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If using the PXIe-5654 with PXIe-5696 , you can also query the temperature of the 
PXIe-5696 AE module with the AE Temperature property or the 
NIRFSG_ATTR_AE_TEMPERATURE attribute. 

Re-enabling the Device After Thermal Shutdown 
Complete the following steps to restore power to the RF enclosure: 

1. Ensure the filters are clean and that you have a clear path for airflow through your 
PXI Express chassis. 

2. Review the guidelines in the Maintain Forced-Air Cooling Note to Users that 
shipped with the device, and make any necessary adjustments to ensure that the 
chassis can cool the device effectively. 

3. Perform a device reset in MAX by selecting the device in the MAX configuration tree 
and clicking Reset from the MAX toolbar. 

Note Serial signals between the sensor and the central processing unit could 
potentially modulate the signal being generated, causing phase spurs. After 
the device is thoroughly warmed up, its temperature varies only slightly and 
slowly, so you do not need to constantly poll the temperature sensor. 
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Unpacking the Kit Unpacking the Kit 

1. Touch the antistatic package to a metal part of the computer chassis. 
2. Remove the device from the package and inspect the device for loose components 

or any other sign of damage. 

3. Unpack any other items and documentation from the kit. 

Verifying the Kit Contents Verifying the Kit Contents 
Figure 1. PXIe-5654 Kit Contents 

1

3 4 5 6

2

1. PXIe-5654 RF Signal Generator Module 
2. Screwdriver, Part Number 772006-01 
3. PXIe-5654 Getting Started Guide 

Notice To prevent electrostatic discharge (ESD) from damaging the device, 
ground yourself using a grounding strap or by holding a grounded object, 
such as your computer chassis. 

Notice Never touch the exposed pins of connectors. 

Note Do not install a device if it appears damaged in any way. 

Note Store the device in the antistatic package when the device is not in use. 

Unpacking the Kit
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4. Read Me First: Safety and Electromagnetic Compatibility 
5. Maintain Forced-Air Cooling Note to Users 
6. Export Requirements Note to Users 

Other Equipment Other Equipment 

There are several required items not included in your device kit that you need to install 
or operate the PXIe-5654 . 

Required Items 

• A PXI Express chassis and chassis documentation. The PXIe-1085 chassis is one 
available option for your device. For more information about compatible chassis 
options, refer to ni.com. 

• A PXI Express embedded controller or MXI controller system that meets the system 
requirements specified in this guide and chassis documentation. 

Optional Items 

• A 1 N · m standard SMA torque wrench (NI part number 780487-01). 

Environment Environment 

Maximum altitude 2,000 m (800 mbar) (at 25 °C ambient temperature) 

Pollution Degree 2 

Indoor use only. 

Operating Environment 

Ambient temperature range 0 °C to 55 °C 

Unpacking the Kit
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Relative humidity range 10% to 90%, noncondensing 

Storage Environment 

Ambient temperature range -40 °C to 71 °C 

Relative humidity range 5% to 95%, noncondensing 

Electromagnetic Compatibility Guidelines Electromagnetic Compatibility Guidelines 
This product was tested and complies with the regulatory requirements and limits for 
electromagnetic compatibility (EMC) stated in the product specifications. These 
requirements and limits are designed to provide reasonable protection against 
harmful interference when the product is operated in the intended operational 
electromagnetic environment. 

This product is intended for use in industrial locations. However, harmful interference 
may occur in some installations, when the product is connected to a peripheral device 
or test object, or if the product is used in residential or commercial areas. To minimize 
interference with radio and television reception and prevent unacceptable 
performance degradation, install and use this product in strict accordance with the 
instructions in the product documentation. 

Furthermore, any modifications to the product not expressly approved by NI could 
void your authority to operate it under your local regulatory rules. 

Caution To ensure the specified EMC performance, operate this product 
only with shielded cables and accessories. 

Caution To ensure the specified EMC performance, the length of all I/O 
cables must be no longer than 3 m (10 ft). 
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Installing the Software Installing the Software 
You must be an Administrator to install NI software on your computer. 

1. Install an ADE, such as LabVIEW or LabWindows™/CVI™. 
2. Download the driver software installer from ni.com/downloads. 

Package Manager downloads with the driver software to handle the installation. 
Refer to the Package Manager Manual for more information about installing, 
removing, and upgrading NI software using Package Manager. 

3. Follow the instructions in the installation prompts. 

4. When the installer completes, select Restart in the dialog box that prompts you to 
restart, shut down, or restart later. 

Note Windows users may see access and security messages during 
installation. Accept the prompts to complete the installation. 

Installing the Software
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Installing the Installing the PXIe-5654 PXIe-5654 

1. Ensure the AC power source is connected to the chassis before installing the 
module. 
The AC power cord grounds the chassis and protects it from electrical damage 
while you install the module. 

2. Power off the chassis. 
3. Inspect the slot pins on the chassis backplane for any bends or damage prior to 

installation. Do not install a module if the backplane is damaged. 
4. Remove the black plastic covers from all the captive screws on the module front 

panel. 
5. Identify a supported slot in the chassis. The following figure shows the symbols 

that indicate the slot types. 
Figure 1. Chassis Compatibility Symbols 

1. PXI Express System Controller Slot 
2. PXI Peripheral Slot 
3. PXI Express Hybrid Peripheral Slot 
4. PXI Express System Timing Slot 
5. PXI Express Peripheral Slot 

PXIe-5654 modules can be placed in PXI Express peripheral slots, PXI Express 
hybrid peripheral slots, or PXI Express system timing slots. 

6. Touch any metal part of the chassis to discharge static electricity. 
7. Ensure that the ejector handle is in the downward (unlatched) position. 
8. Place the module edges into the module guides at the top and bottom of the 

chassis. Slide the module into the slot until it is fully inserted. 

Notice To prevent damage to the PXIe-5654 caused by ESD or 
contamination, handle the module using the edges or the metal bracket. 

Installing the PXIe-5654
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Figure 1. Module Installation 

1. Chassis 
2. Hardware Module 
3. Ejector Handle in Downward (Unlatched) Position 

9. Latch the module in place by pulling up on the ejector handle. 
10. Secure the module front panel to the chassis using the front-panel mounting 

screws. 

11. Cover all empty slots using either filler panels (standard or EMC) or slot blockers 
with filler panels, depending on your application. 

12. Power on the chassis. 

Note All front panel screws must be attached to the PXI chassis to ensure 
all backplane connectors are fully mated. Tightening the mounting 
screws also increases mechanical stability and electrically connects the 
front panel to the chassis, which can improve the signal quality and 
electromagnetic performance. 

Note For more information about installing slot blockers and filler 
panels, go to ni.com/r/pxiblocker. 

Installing the PXIe-5654
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Installing the SMA Cables Installing the SMA Cables 
To operate the modules that comprise the PXIe-5654 , you must interconnect the 
modules using SMA cables. 

1. Connect the cable center pin on the SMA cable to the SMA connector on the 
appropriate device. 

2. Hand-tighten the SMA cable end on the SMA connector after the cable center pins 
are correctly aligned and connected. The cable connectors should tighten without 
much torque or effort. If a cable bends due to incorrect alignment, remove the 
cable from the front panel connector and repeat step 1 before continuing with this 
step. 

3. Use a 1 N · m torque wrench (not included) or RF torque screwdriver and SMA 
driver bit included in your device kit to complete the tightening of the SMA cable to 
1 N · m. Rotate the torque wrench no more than one revolution to tighten the SMA 
cable before reaching maximum torque. 

Direct Connections to the Direct Connections to the PXIe-5654 PXIe-5654 

The PXIe-5654 is a precision RF instrument that is sensitive to ESD and transients. 
Ensure you take the following precautions when making direct connections to the 
PXIe-5654 to avoid damaging the device. 

Notice The signal pins of this product's input/output ports can be damaged 
if subjected to ESD. To prevent damage, remove power from the product 
before connecting cables and employ industry-standard ESD prevention 
measures during installation, maintenance, and operation. 

Note Ensure that the SMA cable center pins properly align with the SMA 
connectors to avoid bending the cable pins or damaging the front panel 
connectors on the device. If the SMA cable does not exactly align with the 
SMA connector, bend the cable slightly by hand to align the cable and the 
connector. The amount of bending should be minimal. The cables can be 
damaged by excessive bending. 
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• Ensure you are properly grounded when manipulating cables or antennas 
connected to the PXIe-5654 . 

• If you are using nonisolated devices, such as a nonisolated RF antenna, ensure the 
devices are maintained in a static-free environment. 

• If you are using an active device, such as a preamplifier or switch routed to the 
PXIe-5654 , ensure no signal transients are sourced to the PXIe-5654 . 

PXIe-5654PXIe-5654  RF Signal Generator Module RF Signal Generator Module 

The PXIe-5654 RF signal generator contains nine connectors and two multicolor LEDs. 

Figure 1. PXIe-5654 RF Signal Generator Module Front Panel 

250 kHz–20 GHz Signal Generator

ACCESS ACTIVE

REF IN
1–20 MHz

±10 dBm NOM
17 dBm MAX

PULSE
IN
–0.5V MIN
+5.5V MAX

FM IN
±1 VDC NOM
±2 VDC MAX

AM IN
±1 VDC NOM
±2 VDC MAX

ALC IN
±15 VDC MAX

RF OUT
250 kHz –
20 GHz

REF OUT
10 MHz

5 dBm ±2 dBm NOM

REF OUT 2
100 MHz

5 dBm ±2 dBm NOM

TRIG
IN/OUT
3.3V CMOS
IN/OUT
–0.5V MIN IN
5.5V MAX IN

ESD
SENSITIVE

ALL PORTS
50 Ω

Table 8. Device Front Panel Icon Definitions 

Refer to the user documentation for required 

Note Do not apply external signals to the PXIe-5654 . Applying external 
signals may cause damage. 
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maintenance measures to ensure user safety 
and/or preserve the specified EMC performance. 

The signal pins of this product's input/output 
ports can be damaged if subjected to ESD. To 
prevent damage, turn off power to the product 
before connecting cables and employ industry-
standard ESD prevention measures during 
installation, maintenance, and operation. 

Table 9. Front Panel Connectors 

Connector Use 

REF IN Input terminal that routes an external reference 
signal to the module. 

REF OUT Output terminal that can route a 10 MHz 
reference signal from the PXIe-5654 . 

REF OUT 2 Output terminal that can route a 100 MHz 
reference signal from the module. 

TRIG IN/OUT 

Input/output terminal that can route a trigger to 
or from the module. 

PULSE IN Input terminal that accepts a modulating square 
wave to pulse the RF output. 

FM IN Input terminal for frequency modulation. 

Caution Do not apply an input 
signal to the TRIG IN/OUT connector 
when it is configured as an output or 
damage may occur. 
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Connector Use 

AM IN Input terminal for amplitude modulation. 

ALC IN Input terminal that connects to the ALC OUT 
connector of the PXIe-5696 AE. 

RF OUT Output terminal for the generated RF signal at 
the requested frequency and power level. 

Table 10. Front Panel LEDs 

LED State Indications 

ACCESS 

Off 

The module is not yet 
functional or has detected a 
problem with a PXI Express 
power rail. 

Amber 

The module is being accessed. 
Accessed means that the 
device setup is being 
transferred in order to control 
the device. 

Green The module is ready to be 
programmed by NI-RFSG . 

ACTIVE 

Off The module is not generating a 
signal. 

Green The module is generating a 

Installing the PXIe-5654

42 ni.com



LED State Indications 

signal; applicable phase-locked 
loops (PLLs) are locked. 

Red 

The module has detected an 
error state; this may indicate a 
PLL lock failure or a thermal 
shutdown condition. 
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Connecting to the Connecting to the PXIe-5654 PXIe-5654 
The PXIe-5654 and PXIe-5696 hardware modules interconnect using semi-regid RF 
cables, included in your hardware kit. 

The following figure illustrates the default hardware configuration of the PXIe-5654
interconnected with the PXIe-5696 . 

250 kHz–20 GHz Signal Generator 250 kHz–20 GHz Amplitude Extender

ACCESS ACTIVE

ACCESS ACTIVE

REF IN
1–20 MHz

±10 dBm NOM
17 dBm MAX

PULSE
IN
–0.5V MIN
+5.5V MAX RF AMP

OUT
ATTN IN

+30 dBm MAX

FM IN
±1 VDC NOM
±2 VDC MAX

AM IN
±1 VDC NOM
±2 VDC MAX

ALC IN
±15 VDC MAX

ALC OUT
±15 VDC MAX

RF OUT
Reverse Power
±30 dBm MAX

RF IN
±15 dBm
MAX

RF OUT
250 kHz –
20 GHz

REF OUT
10 MHz

5 dBm ±2 dBm NOM

REF OUT 2
100 MHz

5 dBm ±2 dBm NOM

TRIG
IN/OUT
3.3V CMOS
IN/OUT
–0.5V MIN IN
5.5V MAX IN

ESD
SENSITIVE

ALL PORTS
50 Ω

ESD
SENSITIVE

ALL PORTS
50 Ω

Refer to the PXIe-5696 Getting Started Guide for instructions on how to 
interconnect the hardware modules. 

The PXIe-5696 helps provide better harmonic suppression or higher output power. You 
can use both of these options in conjunction with the PXIe-5696 ALC or step attenuator 
for better amplitude accuracy and wider amplitude dynamic range by interconnecting 
the PXIe-5654 with the PXIe-5696 , as shown in the preceding figure. 

Connecting to the PXIe-5654
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Low Harmonic Path Versus High Power Path Low Harmonic Path Versus High Power Path 

The PXIe-5696 RF IN connector provides two internal paths, including the low 
harmonic path and the high power path. The low harmonic path provides lower 
second and third harmonic spurious responses, whereas the high power path provides 
higher output power. 

NI-RFSG switches the amplifier to use the low harmonic path to obtain the best 
harmonic performance and switches to the high power path above a certain power 
level. The power level at which the transition occurs varies according to frequency. You 
can override the path chosen by NI-RFSG to specify the amplification path to use. 

ALC Closed Loop Versus Open Loop ALC Closed Loop Versus Open Loop 
The PXIe-5654 with PXIe-5696 has two modes for using the automatic leveling control 
(ALC): ALC disabled (open-loop mode) and ALC enabled (closed-loop mode). 

If the ALC is enabled, the ALC is closed, also known as closed-loop mode. The main 
purpose of the closed loop is to provide greater amplitude accuracy across the whole 
frequency range, from 250 kHz to 20 GHz. When the ALC is closed, the digital-to-analog 
converter (DAC) becomes the master reference for output power, which provides 
greater accuracy. However, the step attenuator hinders the PXIe-5654 switching speed 
when the ALC is closed. 

If the ALC is disabled, the ALC is open, also known as open-loop mode. Open-loop 
mode is ideal for utilizing modulation capabilities. 

You can configure the ALC connection between the PXIe-5654 and PXIe-5696 using the 
default hardware configuration. 

Note Refer to the PXIe-5654 Specifications document for PXIe-5654
second harmonic values. 

Note Refer to the PXIe-5654 Specifications document for PXIe-5654
switching speed values. 
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Verifying the Installation in MAX Verifying the Installation in MAX 
You can use Measurement & Automation Explorer (MAX) to configure your NI hardware. 
MAX informs other programs about which NI hardware products are in the system and 
how they are configured. MAX is automatically installed with NI-RFSG . 

1. Launch MAX. 
2. In the configuration tree, expand Devices and Interfaces to see the list of installed 

NI hardware. 
Installed modules appear under the name of their associated chassis. 

3. Expand your Chassis tree item. 
MAX lists all modules installed in the chassis. Your default names may vary. 

4. Record the name MAX assigns to the hardware. Use this identifier when 
programming the PXIe-5654 . 

5. Self-test the hardware by selecting the item in the configuration tree and clicking 
Self-Test in the MAX toolbar. 
MAX self-test performs a basic verification of hardware resources. 

What Should I Do if the PXIe-5654 Does Not Appear in MAX? 

1. In the MAX configuration tree, expand Devices and Interfaces. 
2. Expand the Chassis tree to see the list of installed hardware, and press <F5> to 

refresh the list. 
3. If the module is still not listed, power off the system, ensure that all hardware is 

correctly installed, and restart the system. 
4. Navigate to the Device Manager by right-clicking the Start button, and selecting 

Device Manager. 
5. Verify the PXIe-5654 appears in the Device Manager. 

Note MAX is not available on Linux. 

Note If you do not see your module listed, press <F5> to refresh the list 
of installed modules. If the module is still not listed, power off the system, 
ensure the module is correctly installed, and restart. 

Verifying the Installation in MAX
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a. Under an NI entry, confirm that a PXIe-5654 entry appears. 

b. If error conditions appear, reinstall NI-RFSG . 

What Should I Do if the PXIe-5654 Fails the Self-Test? 

1. Restart the system. 
2. Launch MAX. 

◦ Failed self-test—Perform self-calibration, then perform the self-test again. The 
PXIe-5654 must be calibrated to pass the self-test. 

◦ Failed self-calibration—Perform self-calibration again. 
3. Power off the chassis. 
4. Reinstall the failed module in a different slot. 
5. Power on the chassis 
6. Perform the self-test again. 

Note If you are using a PC with a device for PXI remote control 
system, under System Devices, also confirm that no error conditions 
appear for the PCI-to-PCI Bridge. 

Verifying the Installation in MAX
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Power On and Reset Conditions Power On and Reset Conditions 
The PXIe-5654 hardware is in the following state after powering on or restarting the 
system and allowing the PC operating system and NI-RFSG to fully load. These 
conditions are also true after a device reset that you perform directly from NI 
Measurement & Automation Explorer (MAX). 

• The RF analog signal generator frequency is set to 1 GHz. 
• The RF analog signal generator power level is set to -7 dBm. 
• The RF output signal is off. 
• The REF IN connector is set to use the internal frequency reference. 
• The REF OUT connector is set to off. 
• The REF OUT 2 connector is set to off. 
• The TRIG IN/OUT connector is configured as in input. 
• The AM IN connector is set to off. 
• The FM IN connector is set to off. 
• The PULSE IN connector is set to off. 
• The ALC is disabled. 
• Thermal shutdown monitoring is activated. 

PXIe-5654 with PXIe-5696 Power On and Reset Conditions 

The PXIe-5654 RF Analog Signal Generator with the PXIe-5696 Amplitude Extender is in 
the following state after powering on or restarting the system. 

• The mechanical attenuator is set to a maximum attenuation of 110 dB. 
• The RF signal generator frequency is set to 1 GHz. 
• The RF signal generator power level is set to -110 dBm. 
• The RF output signal is off. 
• The REF IN connector is set to use the internal frequency reference. 
• The REF OUT connector is set to off. 
• The REF OUT 2 connector is set to off. 
• The TRIG IN/OUT connector is configured as in input. 
• The AM IN connector is set to off. 
• The FM IN connector is set to off. 
• The PULSE IN connector is set to off. 
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• The ALC is disabled. 
• Thermal shutdown monitoring is activated. 

The PXIe-5654 with PXIe-5696 returns to the power-on state after a device reset that 
you perform directly from Measurement & Automation Explorer (MAX). 
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Using the Using the PXIe-5654 PXIe-5654 
Understand how to use the PXIe-5654 , including taking basic measurements, 
programming the PXIe-5654 , and optimizing the performance of complex 
applications. 

Power Search Power Search 
A power search temporarily enables the ALC (closed-loop mode), adjusts the RF output 
power for better accuracy, and then disables the ALC (open-loop mode). Performing a 
power search is useful during modulation, specifically when you desire the accuracy of 
the ALC closed-loop mode but cannot enable ALC because doing so interferes with the 
modulated signal. 

Power search is supported only when using the PXIe-5654 with PXIe-5696 . 

Configuring Power Search Using NI-RFSG 
Perform a power search by completing either of the following options: 

1. Set the Automatic Power Search property to Enable or the 
NIRFSG_ATTR_AUTO_POWER_SEARCH attribute to NIRFSG_VAL_ENABLE for a 
power search to perform once the frequency or power level changes. 

Automatic power search is the default option. 

2. Call the niRFSG Perform Power Search VI or niRFSG_PerformPowerSearch function 
for a power search to perform immediately. 

Power Level Adjustment Power Level Adjustment 
The PXIe-5654 RF signal generator has two modes for power level adjustment: 
automatic leveling control (ALC) disabled (open-loop mode) and ALC enabled (closed-
loop mode). 
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ALC Disabled (Open-Loop Mode) 

As a stand-alone device, the PXIe-5654 open-loop operation mode provides fine 
amplitude adjustment over the power control range and is temperature compensated 
over the operating temperature range. With the PXIe-5654 stand-alone device, you can 
adjust the power level in 0.01 dB steps. 

ALC Enabled (Closed-Loop Mode) 

When you pair the PXIe-5654 with an PXIe-5696 , a 110 dB mechanical step attenuator 
extends the power adjustment range, and the power accuracy improves by engaging 
the ALC loop. 

The ALC loop performs fine amplitude adjustment, and the step attenuator performs 
coarse attenuation in 10 dB steps. The ALC is calibrated for amplitude and temperature 
variation and is used to adjust the power within the power control range of the 
PXIe-5654 . NI-RFSG uses the ALC and step attenuator together to optimize the 
absolute and relative accuracy at the specified power1. 

When the ALC is closed, NI-RFSG sets the amplifier to use the low harmonic path or the 
high power path based on frequency and power settings. Power settings are 
independent of the ALC; however, power level accuracy increases in closed-loop 
mode. 

Programming the Programming the PXIe-5654 PXIe-5654 
You can generate signals interactively using the NI-RFSG Soft Front Panel (SFP), or you 

Note When using the PXIe-5654 as a stand-alone device, only open-loop 
mode is supported because the ALC is in the PXIe-5696 Amplitude Extender 
module. When you use the PXIe-5654 with the PXIe-5696 , both open-loop 
and closed-loop modes are supported. 

Note Refer to the NI PXIe-5654 Specifications document for guaranteed 
output power range and accuracy. 

1. Power accuracy varies depending on power level. 
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can use the NI-RFSG instrument driver to program your device in the supported ADE of 
your choice. 

Table 11. PXIe-5654 Programming Options 

Application Programming 
Interface (API) Location Description 

NI-RFSG SFP 

Available from the Start menu 
at Start » All Programs »
National Instruments » NI-
RFSG » NI-RFSG Soft Front 
Panel. 

The NI-RFSG SFP controls, 
generates, and presents data 
similar to stand-alone RF signal 
generators. The NI-RFSG SFP 
operates on the PC, so it 
provides additional processing, 
storage, and display 
capabilities. 

NI-RFSG Instrument Driver 

LabVIEW—Available on the 
LabVIEW Functions palette at 
Measurement I/O » NI-RFSG. 

NI-RFSG configures and 
operates the device hardware, 
performs waveform 
programming and generation, 
and performs basic modulation 
tasks using LabVIEW VIs or 
LabWindows/CVI functions. 

LabWindows/CVI—Available at 
Program Files » IVI Foundation 
» IVI » Drivers » niRFSG. 

Microsoft Visual C/C++ 

Add all required include and 
library files to your project to 
create an NI-RFSG application 
in Microsoft Visual C/C++. 

Generating a Signal Using the Generating a Signal Using the NI-RFSGNI-RFSG  Soft Front Panel Soft Front Panel 

To verify your device configuration, use the NI-RFSG Soft Front Panel (SFP) in MAX to 
generate a simple signal. 

1. Within MAX, select the PXIe-5654 RF signal generator module in the configuration 
tree. 

2. Select Soft Front Panel from the MAX toolbar. 
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The NI-RFSG SFP launches. 
3. Within the NI-RFSG SFP, specify a frequency and a power level for signal 

generation. 

4. Click RF On/Off to begin signal generation. 

During signal generation, the ACTIVE LED on the PXIe-5654 hardware module 
illuminates. 

5. Click RF On/Off to stop signal generation. 

Related tasks: 

• Verifying the Installation in MAX 
• Why Is the ACCESS LED Off When the Chassis Is On? 

Building a Basic Building a Basic NI-RFSGNI-RFSG  Application Application 

You can build a basic NI-RFSG application in LabVIEW for generating continuous sine 
wave signals. 

Adding the Core Adding the Core NI-RFSGNI-RFSG  VIs to a Blank VI VIs to a Blank VI 

Create a new application that includes the core NI-RFSG VIs. 

1. Launch LabVIEW. 
2. To create a blank VI, select File » New VI. 
3. Display the block diagram by selecting Window » Show Block Diagram. 

Caution Clicking RF On/Off generates a signal from the RF OUT 
connector of the PXIe-5654 front panel. Disconnect any equipment that 
can be damaged by the test signal prior to clicking the RF On/Off button 
on the NI-RFSG SFP. 

Note Refer to Why Is the ACCESS LED Off When the Chassis Is 
On? topic or Verifying the Installation in MAX section of this 
document if an ACTIVE LED does not turn on or if the NI-RFSG SFP 
generates an error. 
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4. Right-click the VI block diagram to launch the Functions palette. 
5. Navigate to the NI-RFSG VIs on the NI-RFSG palette. 

6. Add the core NI-RFSG VIs from the NI-RFSG palette to the block diagram, and wire 
the VIs together as shown in the following figure. 
Figure 1. Basic NI-RFSG Block Diagram 

7. Right-click the resource name input on the niRFSG Initialize VI, and select 
Create » Control to create a front panel control where you specify the RF signal 
generator device name. 
Figure 1. Resource Name Input on the niRFSG Initialize VI 

8. Right-click the frequency (Hz) input on the niRFSG Configure RF VI, and select 
Create » Control. 

9. Right-click the power level (dBm) input on the niRFSG Configure RF VI, and 
select Create » Control. 

10. Display the VI front panel by clicking it or by selecting Window » Show Front Panel. 
11. In the VI front panel power level (dBm) control, enter 0. In the frequency (Hz) 

control, enter 100M (100 MHz). 
12. In the VI front panel resource name control, enter the PXIe-5654 device name that 

you specified in MAX. 

Adding a While Loop Adding a While Loop 

Add a While Loop to continuously generate the signal and check the generation status 
until you click the Stop button. 

1. Display the VI block diagram, and select the While Loop on the Structures palette. 

Tip Activate the LabVIEW context help by selecting Help » Show Context 
Help. 

Tip You can use the Search button on the Functions palette to find the 
NI-RFSG palette. 
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2. Enclose the niRFSG Check Generation Status VI in the While Loop, as shown in the 
following figure. 
Figure 1. The niRFSG Check Generation Status VI Enclosed in the While Loop 

3. Right-click the While Loop tunnels, and select Replace with Shift Register. 
4. Select the Or function on the Boolean palette. Place the function inside the While 

Loop. 
5. Wire the output of the Or function to the conditional terminal of the While Loop. 
6. Select the Unbundle by Name function on the Cluster, Class, & Variant palette. 

Place the function inside the While Loop. 
7. Wire the error out output of the niRFSG Check Generation Status VI to the 

Unbundle by Name function. 
8. Wire the output of the status element to an input of the Or function. 
9. Right-click the unused input of the Or function, and select Create » Control to 

create a Boolean control. 
10. In the VI front panel, right-click the Boolean control created in step 9, and select 

Replace » Modern » Boolean » Stop Button to create a Stop button. 
Figure 1. While Loop with Stop Button 

Tip You can use the Search button on the Functions palette to find the 
Structures palette. 
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Adding an Error Indicator Adding an Error Indicator 

Add an error indicator to the VI front panel. 

1. Create an error indicator by right-clicking the error out output of the niRFSG 
Close VI and selecting Create » Indicator. 

2. Verify that the VI block diagram and VI front panel now look similar to the following 
figures. 
Figure 1. Basic Sine Wave Generation VI Block Diagram 

Figure 1. Basic Sine Wave Generation VI Front Panel 

3. Open the VI front panel, and select the PXIe-5654 module name specified in MAX in 
the resource name control. 

4. Click the Run button on the toolbar to initiate sine wave generation. 

Using the PXIe-5654

56 ni.com



5. Click the VI front panel STOP button to stop sine wave generation. 

You have successfully generated a continuous sine wave signal using the NI-RFSG
instrument driver and the PXIe-5654 . 

Modulation Schemes Modulation Schemes 
The PXIe-5654 /5654 with PXIe-5696 can generate the following types of modulated 
signals: 

Amplitude Modulation (AM) Amplitude Modulation (AM) 

AM is a process that varies the amplitude of an RF carrier signal proportional to the 
amplitude of the message signal. 

The PXIe-5654 /5654 with PXIe-5696 does not provide a calibrated AM function; rather, 
you can supply a message signal for the device to modulate. Apply the modulating 
signal at the PXIe-5654 AM IN connector, where the nominal input signal is ±1 V, and 
the input damage level of the modulating signal is ±2 V. 

Using NI-RFSG , you can adjust the AM sensitivity to the appropriate level to achieve 
the desired AM profile. 

Frequency Modulation (FM) Frequency Modulation (FM) 

FM is a form of modulation in which changes in the frequency of the carrier wave 
correspond directly with changes in the message signal. 

The PXIe-5654 /5654 with PXIe-5696 does not provide a calibrated FM function; rather, 
you can supply a message signal for the device to modulate. Apply the modulating 
signal at the PXIe-5654 FM IN connector, where the nominal input signal is ±1 V, and 
the input damage level of the modulating signal is ±2 V. 

You can control the following frequency modulation characteristics: 

• FM band (narrowband or wideband) 
• FM narrowband integration 
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• FM sensitivity 

Using NI-RFSG , you can select the FM band to apply, specify a FM narrowband 
modulating signal rate range, and adjust the FM sensitivity to the appropriate level to 
achieve the desired FM profile. 

FM Bands 

The following table indicates the appropriate FM band to use in relation to the rate of 
the modulating signal. 

Modulating Signal Rate FM Band 

100 Hz to 1 kHz 

Narrowband 1 kHz to 10 kHz 

10 kHz to 100 kHz 

>100 kHz Wideband 

Use the wideband FM band when you seek FM at modulation rates greater than 
100 kHz. Wideband FM has the added benefit that it can achieve relatively higher 
deviations than narrowband FM. 

FM Narrowband Integration 

Phase modulation is related to frequency modulation by integration. 

For closed-loop frequency modulation, the device implements phase modulation and 
processes the modulating signal through an integrator. An integrator can cause 
significant loss with increasing frequency. Integrators have a frequency response that 
rolls off proportional to 1 divided by the modulating frequency. Select the narrowband 
integrator as recommended in the preceding table. 

Phase Modulation (PM) Phase Modulation (PM) 

PM is a type of modulation in which the phase angle of a carrier wave deviates from its 
reference value by an amount proportional to the instantaneous value of the 
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modulating signal. 

The PXIe-5654 /5654 with PXIe-5696 does not provide a calibrated PM function; rather, 
you can supply a message signal for the device to modulate. Apply the modulating 
signal at the PXIe-5654 FM IN connector, where the nominal input signal is ±1 V, and 
the input damage level of the modulating signal is ±2 V. 

You can control the following phase modulation characteristics: 

• PM mode 
• PM sensitivity 

Using NI-RFSG , you can select the PM mode to apply and adjust the PM sensitivity to 
the appropriate level to achieve the desired PM profile. 

PM Modes 

You can apply PM in either high deviation mode or low phase noise mode. Low phase 
noise mode is ideal when you require the ability to adjust the phase of the RF signal 
and utilize low phase noise simultaneously, allowing the device to meet its phase 
noise specification. High deviation mode provides higher phase deviation, but the 
modulating signal has higher phase noise and may not meet the device phase noise 
specification. 

Pulse Modulation Pulse Modulation 

The PXIe-5654 /5654 with PXIe-5696 allows you to do pulse modulation, and you apply 
the modulating signal at the PXIe-5654 PULSE IN connector. 

The modulating signal levels should be consistent with transistor-transistor logic (TTL) 
levels. The damage levels of the PXIe-5654 PULSE IN connector are ≤-0.5 V and ≥5.5 V. 
The modulating frequency should be ≤10 MHz. At high modulation frequencies, pulse 
width compression occurs. To achieve 50% duty cycle, you may need to increase the 
duty cycle of the modulating signal. 

Note Refer to the PXIe-5654 Specifications document for specified 
phase noise performance. 
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Using NI-RFSG , you can select the pulse modulation mode to apply to achieve the 
desired pulse modulation profile. 

Pulse Modulation Modes 

You can apply pulse modulation in either the optimal match mode or high isolation 
mode. High isolation mode allows for the best on/off power ratio of the pulsed signal. 
Optimal match mode provides for a more optimal power output match for the 
PXIe-5654 /5654 with PXIe-5696 during the off cycle of the pulse mode operation. 
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Maintaining Maintaining PXI ExpressPXI Express  Systems Systems 
Clean the fan filters on the chassis regularly to prevent fan blockage and ensure 
efficient air circulation. 

Cleaning frequency depends on the amount of use and the operating environment. For 
specific information about cleaning procedures and other recommended 
maintenance, refer to the module specifications and the chassis user documentation. 

Uninstalling the Hardware 

1. Power off the chassis. 
2. Ground yourself with a grounding strap or touch a grounded metal surface. 
3. Disconnect any cables from the module front panel connectors. 
4. Unlatch the module by pushing down on the ejector handle. 
5. Pull the ejector handle and hold the module by the edges to remove it from the 

chassis. 

Store the module in the original antistatic packaging when not in use to avoid damage. 

Notice Disconnect or disable any external RF, clock, or digital connections 
to the device front panel. Applying external signals while the device is 
powered off may cause damage. 

Notice Do not disconnect the cable that connects CAL IN to CAL OUT. 
Removing the cable from or tampering with the CAL IN or CAL OUT front 
panel connectors voids the product calibration and specifications are no 
longer warranted. 
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PXIe-5654PXIe-5654  Factory Calibration Factory Calibration 
NI performs calibration of the PXIe-5654 that is relative to an NIST-traceable standard 
over the specified operating temperature range. Every PXIe-5654 is individually 
calibrated at the factory for accurate frequency and amplitude response. 

For frequency accuracy, the 100 MHz system clock is calibrated against an NIST-
traceable rubidium clock at room temperature and over the PXIe-5654 operating 
temperature range. It is important that the PXIe-5654 temperature stabilizes before 
critical frequency accuracy measurements are taken. The PXIe-5654 uses a high quality 
oven-controlled crystal oscillator (OCXO) as a frequency reference, and because the 
OCXO is heated and operates at a temperature higher than the ambient air 
temperature, it is less susceptible to temperature variations. 

For amplitude accuracy, the internal attenuators are calibrated over the entire 
specified temperature and amplitude range. The amplitude accuracy is calibrated 
against an NIST-traceable power meter for all power levels. 

For more information about calibration, contact NI or visit ni.com/calibration. 

PXIe-5696 Factory Calibration 

NI performs calibration of the PXIe-5696 that is relative to an NIST-traceable standard 
over the specified operating temperature range. Every PXIe-5696 is individually 
calibrated at the factory for accurate amplitude response. Both amplifiers (low 
harmonic and high power), automatic leveling control (ALC), and attenuators are 
calibrated over the entire frequency range. 

Note Refer to the PXIe-5654 Specifications document for detailed 
specifications. 

Notice Opening the RF enclosure invalidates factory calibration. To preserve 
guaranteed calibration, do not disassemble the PXIe-5654 RF enclosure. 
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For more information about calibration, contact NI or visit ni.com/calibration. 

Note Refer to the PXIe-5654 Specifications document for detailed 
PXIe-5654 with PXIe-5696 specifications. 

Notice Opening the RF enclosure invalidates factory calibration. To preserve 
guaranteed calibration, do not disassemble the PXIe-5654 or PXIe-5696 RF 
enclosure. 

© 2025 National Instruments Corporation. 
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